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1 Introduction

deegree is a Java Framework offering the main building blocks for Spatial Data 
Infrastructures (SDIs). Its entire architecture is developed using standards of the 
Open  Geospatial  Consortium  (OGC)  and  ISO  Technical  Committee  211  – 
Geographic  information  /  Geoinformatics  (ISO/TC  211).  deegree  encompasses 
OGC Web Services as well as clients. deegree is Free Software protected by the 
GNU  Lesser  General  Public  License  (GNU  LGPL)  and  is  accessible  at 
http://www.deegree.org.

deegree2  is  the  new  release  of  deegree  supporting  a  number  of  features 
deegree1  was  not  able  to  handle.  This  documentation  describes  setup  and 
configuration of deegree Web Map Print Service (WMPS), a service for creating 
large format, high resolution maps for a defined extent or scale. Data sources are 
OGC Web  Map  Services  but  also  different  kinds  of  vector  data  formats.  The 
printout is done on a central plotter that is directly accessed by the service or via 
a saved print file (*.pdf, *.html, *.rtf).

An administrator is responsible for connecting the print service to different data 
sources and the used printer as well as offering templates to the users of the 
service.
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Besides a WMPS, deegree comprises a number of additional services and clients.  
A complete list of deegree components can be found at:

http://www.lat-lon.de  Products

Downloads of packaged deegree components can be found at:

http://www.deegree.org  Download

deegree's  Web  Map  Print  Service  offers  great  flexibility  regarding  its 
configuration  and  adaption  to  different  data  sources,  formats  and  server 
environments. The configuration of WMPS is similar to the configuration of other 
deegree web services and requires editing of different XML files which control the 
functionality of the server.

The web services  of  deegree are realized as Java modules controlled by one 
central  servlet  (a  “dispatcher”).  This  servlet  has  to  be  integrated  into  the 
respective web server/servlet engine. Most of the common web servers support 
servlet  technology,  thus  making  deegree  a  universal  product.  The  Apache-
Tomcat 5.5 Servlet-Engine is recommended due to its widespread use and its 
status as an open-source product.
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2 Download / Installation

2.1 Prerequisites

For deegree2 WMPS to run you need:

➢ Java (JRE or JSDK) version 1.5.x

➢ Tomcat 5.5.x (do not use 5.5.26!)

For installation of these components refer to the corresponding documentation at 
java.sun.com and tomcat.apache.org.

2.2 deegree Web Map Print Service release

So far no demo download package is available for deegree WMPS. Therefore you 
have to get the necessary files from the deegree SVN.

To set up a print service you need to set up the following components:

➢ a configuration for the WMPS

➢ a deegree2.jar (either precompiled or created from the classes in the SVN.

Your $wmps_home$ will contain the following structure:

directory Content
./WEB-INF Required  by  Tomcat,  containing  all 

libraries, configuration- and data-files
./WEB-INF/conf/wmps WMS configuration files

Table 1: Directory structure of a WMPS installation

2.3 Testing the installation

Check the installation by issuing the following request:

http://MyServer:8080/deegree/wmps?request=GetCapabilities& 
version=1.0.0&service=WMPS
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3 Functionality
The functionality of the print service is generally speaking to respond to printing 
requests  that  use the query format described in the following as well  as  the 
asynchronous processing of printing requests. Asynchronity is necessary as it is 
possible that:

a) several  printing  requests  arrive  simultaneously,  but  only  one  printer  is 
available,

b) the processing of a print service takes a longer period of time and the 
network connection to the client can/should not be kept during this time.

After  receiving  a  printing  request,  this  is  first  stored  in  a  request  queue  (a 
database).  As  soon  as  the  printing  service  again  has  enough resources  –  no 
printing request is in procession – the oldest print request is fetched from the 
queue and passed on for procession (Fig. 2).

Using its configuration, that is in most part identical to one of deegree WMS, the 
print service decides which part of a request is passed on to available WMSs and 
which part  it  processes itself.  The former  means that  after  calculating of  the 
corresponding BoundingBox and picture size the map is requested in a number of 
tiles to not overstep the capacities of the used WMS. To take over part of the 
map creation process the service needs access to the corresponding vector data 
sources (e.g. Databases). The requests to these data sources do not have to be 
tiled  as  it  can  be  assumed  that  the  requested  data  volume  is  acceptable. 
Furthermore the printing service respectively its administrator is responsible for 
defining the amount of time a service may use to process a request.

In a first step the print service draws the background layers from the used WMS, 
afterwards the vector data that is directly processes by the printing service is 
drawn  on  top.  After  completing  the  printing  process  the  user  who  sent  the 
printing  request  is  informed  via  E-Mail.  Depending  on  the  requested  image 
format the Email also states that the map printout has to be fetched from the 
administrator or includes a link to the created document.

The administrator can declare position and size of the map as well as its title, 
legend, scale bar and north arrow as well as an additional text using a template 
(see below).
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The print service support two operations: GetCapabilities and PrintMap. The first 
operation corresponds in regard to its functionality to other OGC Web Services 
(OWS). The response is a XML-document that in general looks like a WMS 1.1.1 
Capabilities document and gives information about the capabilities of the WMPS. 
The  second  operation  serves  the  need  to  create  maps.  As  PrintMap  is  a 
asynchronous operation its response is a confirmation of receiving the request. 
After the print request is finished or it failed the user will be informed about the 
status.
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4 Requests

4.1 GetCapabilities-Request

The GetCapabilities operation is only defined for HTTP-Get.

Request Parameter Required/Op
tional

Description

REQUEST R Request name

VERSION=version O Version of Service (default 1.0.0)

SERVICE=WMPS R Service Type

Table 2: GetCapabilities request parameters

Example:

http://MyServer:8080/deegree/wmps?request=GetCapabilities& 
version=1.0.0&service=WMPS

4.2 GetCapabilities-Response

The response to a GetCapabilities request is almost identical to the one by a OGC 
WMS 1.1.1. Only the Request section is adjusted so that instead of the WMS-
specific operations only GetCapabilities and PrintMap can be listed.

Example:
<?xml version="1.0" encoding="UTF-8"?>
<WMPS_Capabilities xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" 

version="1.1.1" updateSequence="1.1.0">
    <Service>
        <Name>WMPS</Name>
        <Title>deegree wmps</Title>
        <Abstract>wms reference implementation</Abstract>
        <KeywordList>
            <Keyword>deegree</Keyword>
            <Keyword>wmps</Keyword>
        </KeywordList>
        <OnlineResource xmlns:xlink="http://www.w3.org/1999/xlink" 

xlink:type="simple" xlink:href="http://www.deegree.org"/>
        <ContactInformation>
            <ContactPersonPrimary>
                <ContactPerson>Andreas Poth</ContactPerson>
                <ContactOrganization>lat/lon</ContactOrganization>
            </ContactPersonPrimary>
            <ContactPosition>Senior Consultant</ContactPosition>
            <ContactAddress>
                <AddressType>Postal</AddressType>
                <Address>Aennchenstr. 19</Address>
                <City>Bonn</City>
                <StateOrProvince>NRW</StateOrProvince>
                <PostCode>53177</PostCode>
                <Country>Germany</Country>
            </ContactAddress>
            <ContactVoiceTelephone>0049228184960</ContactVoiceTelephone>
            <ContactFacsimileTelephone>00492281849629</ContactFacsimileTelephone>
            <ContactElectronicMailAddress>info@lat-lon.de

 </ContactElectronicMailAddress>
        </ContactInformation>
        <Fees>none</Fees>
        <AccessConstraints>none</AccessConstraints>
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    </Service>
    <Capability>
        <Request>
            <GetCapabilities>
                <Format>application/vnd.ogc.wms_xml</Format>
                <DCPType>
                    <HTTP>
                        <Get>
                            <OnlineResource

 xmlns:xlink="http://www.w3.org/1999/xlink" 
 xlink:type="simple" 
 xlink:href="http://127.0.0.1:8080/deegree-

wmps/services?"/>
                        </Get>
                    </HTTP>
                </DCPType>
            </GetCapabilities>
            <PrintMap>

  <Format>default</Format>
  <Format>LegendOnBottom</Format>
  <Format>LegendRight</Format>
  <Format>MyTemplate</Format>

                <DCPType>
                    <HTTP>
                        <Get>
                            <OnlineResource 

xmlns:xlink="http://www.w3.org/1999/xlink" 
xlink:type="simple" 
xlink:href="http://127.0.0.1:8080/deegree-

wmps/services?"/>
                        </Get>
                    </HTTP>
                </DCPType>
            </PrintMap>
        </Request>
        <Exception>
            <Format>application/vnd.ogc.se_xml</Format>
            <Format>application/vnd.ogc.se_inimage</Format>
            <Format>application/vnd.ogc.se_blank</Format>
        </Exception>
        <!-- optional; default = all false -->
        <UserDefinedSymbolization SupportSLD="1" UserLayer="1" UserStyle="1"

 RemoteWFS="0"/>
        <Layer queryable="0" cascaded="0" noSubsets="0">
            <Title>Test WMPS</Title>
            <Abstract>WMPS of the Geoportal of the Metropolregion

 Hamburg</Abstract>
            <KeywordList>
                <Keyword>deegree</Keyword>
                <Keyword>layer</Keyword>
            </KeywordList>
            <SRS>EPSG:4326</SRS>
            <LatLonBoundingBox minx="-180" miny="-90" maxx="180" maxy="90"/>
            <ScaleHint min="0" max="100000000"/>
            <Layer queryable="0" cascaded="0" noSubsets="0">
                <Title>MRH layers</Title>
                <SRS>EPSG:31467</SRS>
                <LatLonBoundingBox minx="6" miny="51" maxx="13" maxy="56"/>
                <Layer queryable="1" noSubsets="0" fixedWidth="0" fixedHeight="0">
                    <SRS>EPSG:31467</SRS>
                    <Name>mrh:kreise</Name>
                    <Title>Kreise der Metropolregion Hamburg</Title>
                    <Style>
                        <Name>default:mrh:kreise</Name>
                        <Title>default:mrh:kreise</Title>
                    </Style>
                </Layer>
                <Layer queryable="1" noSubsets="0" fixedWidth="0" fixedHeight="0">
                    <SRS>EPSG:31467</SRS>
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                    <Name>mrh:gemeinden</Name>
                    <Title>Gemeinden der Metropolregion Hamburg</Title>
                    <Style>
                        <Name>default:mrh:gemeinden</Name>
                        <Title>default:mrh:gemeinden</Title>
                    </Style>
                </Layer>
            </Layer>
            <Layer queryable="0" cascaded="0" noSubsets="0">
                <Title>Hamburg layers</Title>
                <SRS>EPSG:31467</SRS>
                <LatLonBoundingBox minx="6" miny="51" maxx="13" maxy="56"/>
                <Layer queryable="1" noSubsets="0" fixedWidth="0" fixedHeight="0">
                    <SRS>EPSG:31467</SRS>
                    <Name>hamburg:bezirke</Name>
                    <Title>Bezirke von Hamburg</Title>
                    <Style>
                        <Name>default:hamburg:bezirke</Name>
                        <Title>default:hamburg:bezirke</Title>
                    </Style>
                </Layer>
                <Layer queryable="1" noSubsets="0" fixedWidth="0" fixedHeight="0">
                    <Name>hamburg:FFH-Flaechen</Name>
                    <Title>hamburg:FFH-Flaechen</Title>
                </Layer>
                <Layer queryable="1" noSubsets="0" fixedWidth="0" fixedHeight="0">
                    <Name>hamburg:gewaesserguete99_flaechen</Name>
                    <Title>hamburg:gewaessergute99_flaechen</Title>
                </Layer>
                <Layer queryable="1" noSubsets="0" fixedWidth="0" fixedHeight="0">
                    <Name>hamburg:wasserschutzgebiete</Name>
                    <Title>hamburg:wasserschutzgebiete</Title>
                </Layer>
                <Layer queryable="1" noSubsets="0" fixedWidth="0" fixedHeight="0">
                    <Name>hamburg:landschaftsschutzgebiete</Name>
                    <Title>hamburg:landschaftsschutzgebiete</Title>
                </Layer>
                <Layer queryable="1" noSubsets="0" fixedWidth="0" fixedHeight="0">
                    <Name>hamburg:oberflaechengewaesser</Name>
                    <Title>hamburg:oberflaechengewaesser</Title>
                </Layer>
                <Layer queryable="1" noSubsets="0" fixedWidth="0" fixedHeight="0">
                    <Name>hamburg:gewaesserflaechen</Name>
                    <Title>hamburg:gewaesserflaechen</Title>
                </Layer>
            </Layer>
        </Layer>
    </Capability>
</WMPS_Capabilities>
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4.3 GetAvailableTemplates

(deegree2 >=2.4) 

The GetAvailableTemplates operation is only defined for HTTP-Get. It returns a 
list of templates, which are provided by the WMPS.

Request Parameter Required/
Optional

Description

REQUEST=GetAvailableTemplates R Requests list of available templates

VERSION=version O Version of Service (default 1.0.0)

SERVICE=WMPS R Service Type

Table 3: GetAvailableTemplates request parameters

Examplerequest:

http://localhost:8080/deegree-wmps/services?
SERVICE=WMPS&REQUEST=GetAvailableTemplates&version=1.0.0

Exampleresponse:

<?xml version="1.0" encoding="UTF-8"?>
<deegreewmps:GetAvailableTemplatesResponse 
xmlns:deegreewmps="http://www.deegree.org/wmps">
   <Template xmlns="http://www.deegree.org/wmps">template_2</Template>
   <Template xmlns="http://www.deegree.org/wmps">template_1</Template>
   <Template xmlns="http://www.deegree.org/wmps">default</Template>
</deegreewmps:GetAvailableTemplatesResponse>

4.4 DescribeTemplate

(deegree2 >=2.4)

The  DescribeTemplate  operation  is  only  defined  for  HTTP-Get.  It  returns  the 
available elements of a requested template. 

Request Parameter Required/Op
tional

Description

REQUEST=DescribeTemplate R Describes chosen template

VERSION=version O Version of Service (default 1.0.0)

SERVICE=WMPS R Service Type

TEMPLATE=templatename R

Table 4: DescribeTemplate request parameters

Examplerequest:

http://localhost:8080/deegree-wmps/services?
SERVICE=WMPS&REQUEST=DescribeTemplate&version=1.0.0&template=report1

Exampleresponse:
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<?xml version="1.0" encoding="UTF-8"?>
<deegreewmps:DescribeTemplateResponse xmlns:deegreewmps="http://www.deegree.org/wmps">
   <Parameter xmlns="http://www.deegree.org/wmps" name="TITLE" type="java.lang.String"/>
   <Parameter xmlns="http://www.deegree.org/wmps" name="LOGO_URL" type="java.lang.String"/>
   <Parameter xmlns="http://www.deegree.org/wmps" name="AUTHOR" type="java.lang.String"/>
   <Parameter xmlns="http://www.deegree.org/wmps" name="DESCRIPTION" type="java.lang.String"/>
   <Parameter xmlns="http://www.deegree.org/wmps" name="DATE" type="java.lang.String"/>
   <Parameter xmlns="http://www.deegree.org/wmps" name="SCALE" type="java.lang.String"/>
   <Parameter xmlns="http://www.deegree.org/wmps" name="NOTES" type="java.lang.String"/>
   <Parameter xmlns="http://www.deegree.org/wmps" name="COPYRIGHT" type="java.lang.String"/>

</deegreewmps:DescribeTemplateResponse>

4.5 PrintMap-Request

Using the PrintMap request a user initializes a print request. This includes besides 
the content that has to be printed information about the template that defined 
how the elements to be printed have to be ordered. Information about available 
templates can be extracted from the Format elements of the PrintMap request in 
the WMPS capabilities document. The number of templates available is declared 
by  the  administrator  of  the  service.  A  template  named  'default'  is  always 
available. The PrintMap request is defined for Key-Value-Pair encoding for HTTP-
Get as well as XML encoding for HTTP-Post.

4.6 KVP - HTTP Get

Request Parameter Required/Op
tional

Description

REQUEST=PrintMap R Request name

VERSION=Version O Version of the service (default 1.0.0)

LAYERS=Layer list R Comma-separated  list  of  requested 
layers.

STYLES=Style list R Comma-separated  list  of  requested 
styles.

SRS=namespace:identifier R Spatial reference system

BBOX=minx,miny,maxx,maxy C BoundingBox  of  map  is  needed  if 
CENTER and SCALE are not supplied.

CENTER=x,y C Centre  point  of  the  map,  has  to  be 
supplied if BBOX is not defined. SCALE 
is required for this Parameter.

SCALE=n C Scale of the map: has to be supplied if 
BBOX is not defined.

TRANSPARENT=TRUE/FALSE O Background  transparency  (default  = 
FALSE)

BGCOLOR=color O Definition  of  background  colour  as 
hexadecimal (default = 0xFFFFFF)

TITLE=title O Title of the map.

COPYRIGHT=Copyright notice O Copyright-notice

LEGEND=TRUE/FALSE O Declares if  a legend is to  be printed 
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Request Parameter Required/Op
tional

Description

(default =  false)

SCALEBAR=TRUE/FALSE O Declares if a scale bar is to be printed 
(default = false)

NOTE=Text O Additional text to be printed.

TEMPLATE=name O Template to be used for arrangement 
of map elements (default = default ) 

DPI=n O Print resolution (default is  specified in 
WMPS  configuration)  (deegree2 
>=2.4) 

EMAILADDRESS=mail_adresse R Address  that  will  be  notified  about 
success or failure of printing process.

Table 5: GetCapabilities request parameters

4.7 XML-encoding HTTP-POST

The request encoding is defined by the following schema:

<?xml version="1.0" encoding="UTF-8"?>
<xs:schema targetNamespace="http://www.deegree.org/wmps" 
xmlns:xs="http://www.w3.org/2001/XMLSchema" 
xmlns:deegree="http://www.deegree.org/wmps" 
xmlns:sld="http://www.opengis.net/sld" 
xmlns:gml="http://www.opengis.net/gml" elementFormDefault="qualified">

<xs:import namespace="http://www.opengis.net/gml" 
schemaLocation="geometryBasic0d1d.xsd"/>

<xs:import namespace="http://www.opengis.net/sld" 
schemaLocation="StyledLayerDescriptor.xsd"/>

<xs:element name="PrintMap">
<xs:complexType>

<xs:sequence>
<xs:element name="Layers" type="deegree:LayersType"/>
<xs:choice>

<xs:element ref="gml:Envelope"/>
<xs:sequence>

<xs:element name="Center" type="deegree:CenterType"/>
<xs:element name="ScaleDenomiator" type="xs:positiveInteger"/>

</xs:sequence>
</xs:choice>
<xs:element name="Transparent" type="xs:boolean" minOccurs="0" 

default="false"/>
<xs:element name="BGColor" type="xs:string" minOccurs="0" 

default="0xFFFFFF"/>
<xs:element name="Legend" type="xs:boolean" minOccurs="0" 

default="false"/>
<xs:element name="ScaleBar" type="xs:boolean" minOccurs="0" 

default="false"/>
<xs:element name="Template" type="xs:string" minOccurs=“0“ 

  default=“default“/>  
<xs:element name="EMailAddress" type="xs:string"/>
<xs:element name="TextAreas" type="deegree:TextAreasType" 

minOccurs="0"/>
</xs:sequence>
<xs:attribute name="version" type="xs:string" use="required"/>

</xs:complexType>
</xs:element>
<xs:complexType name="LayersType">

<xs:sequence>
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<xs:choice>
<xs:element ref="sld:NamedLayer" minOccurs="1" maxOccurs="unbounded"/>
<xs:element ref="sld:UserLayer" minOccurs="1" maxOccurs="unbounded"/>

</xs:choice>
</xs:sequence>

</xs:complexType>
<xs:complexType name="TextAreaType">

<xs:sequence>
<xs:element name="Name" type="xs:string"/>
<xs:element name="Text" type="xs:string"/>

</xs:sequence>
</xs:complexType>
<xs:complexType name="TextAreasType">

<xs:sequence>
<xs:element name="TextArea" type="deegree:TextAreaType" minOccurs="1" 

maxOccurs="unbounded"/>
</xs:sequence>

</xs:complexType>
<xs:complexType name="CenterType">

<xs:sequence>
<xs:element ref="gml:pos"/>

</xs:sequence>
</xs:complexType>

</xs:schema>

In  the  current  version  of  the  service  only  sld:NamedLayer  are  supported  for 
declaration of the layers to be printed.

Example:

<?xml version="1.0" encoding="UTF-8"?>
<deegree:PrintMap xmlns:deegree="http://www.deegree.org/wmps" 
xmlns:sld="http://www.opengis.net/sld" xmlns:gml="http://www.opengis.net/gml" 
version="1.0.0">

<deegree:Layers>
<sld:NamedLayer>

<sld:Name>europe:physical</sld:Name>
<sld:NamedStyle>

<sld:Name>default</sld:Name>
</sld:NamedStyle>

</sld:NamedLayer>
<sld:NamedLayer>

<sld:Name>europe:major_rivers</sld:Name>
<sld:NamedStyle>

<sld:Name>default</sld:Name>
</sld:NamedStyle>

</sld:NamedLayer>
</deegree:Layers>

   <!-- either bbox using gml envelope -->
<gml:Envelope srsName="EPSG:4326">

<gml:pos>3 42</gml:pos>
<gml:pos>12 55</gml:pos>

</gml:Envelope>
   <!-- or deegree specific 'Center' with gml pos →
   <!--
   <deegree:Center srsName="EPSG:4326">
      <gml:pos>3 42</gml:pos>
   </deegree:Center>
   <deegree:ScaleDenominator>100000</deegree:ScaleDenominator>
   -->       

<deegree:DPI>72</deegree:DPI>
<deegree:Transparent>false</deegree:Transparent>
<deegree:BGColor>0xFF34F2</deegree:BGColor>
<deegree:Legend>true</deegree:Legend>
<deegree:ScaleBar>true</deegree:ScaleBar>
<deegree:Template>MyPrintTemplate</deegree:Template>
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<deegree:EMailAddress>poth@lat-lon.de</deegree:EMailAddress>
<deegree:TextAreas>

<deegree:TextArea>
<deegree:Name>Title</deegree:Name>
<deegree:Text>Meine Karte</deegree:Text>

</deegree:TextArea>
<deegree:TextArea>

<deegree:Name>Copyright</deegree:Name>
<deegree:Text>(c) deegree 2009</deegree:Text>

</deegree:TextArea>
<deegree:TextArea>

<deegree:Name>MeineBeschreibung1</deegree:Name>
<deegree:Text>Dies ist meine erste gedruckte Karte</deegree:Text>

</deegree:TextArea>
<deegree:TextArea>

<deegree:Name>MeineBeschreibung2</deegree:Name>
<deegree:Text>Dies ist ein weiterer Beispieltext</deegree:Text>

</deegree:TextArea>
</deegree:TextAreas>

</deegree:PrintMap>

4.8 PrintMap-Response

As a PrintMap request initiates an asynchronous operation, its response is divided 
into two independent parts. Instantly after  the request is sent by the user, he 
receives a response that notifies him/her if the request was received successfully 
or if  there were errors in parsing it.  Errors can e.g. be caused by incomplete 
requests  or  requests  for  resources  that  are  not  present  (also  see  chapter 
Exceptions).  The  confirmation  of  the  successful  acceptance  of  the  request  is 
defined by an XML document according to the following schema:

<?xml version="1.0" encoding="UTF-8"?>
<xs:schema targetNamespace="http:www.deegree.org/wmps"
 xmlns:wmps="http:www.deegree.org/wmps" xmlns:xs="http://www.w3.org/2001/XMLSchema"
 elementFormDefault="qualified" attributeFormDefault="unqualified">
    <xs:element name="PrintMapResponse" type="wmps:PrintMapResponseType"/>
    <xs:complexType name="PrintMapResponseType">
        <xs:sequence>
            <xs:element name="timestamp" type="xs:time"/>
            <xs:element name="message" type="xs:string" minOccurs="0"/>
            <xs:element name="expectedProcessingTime" type="xs:duration"
 minOccurs="0"/>
        </xs:sequence>
    </xs:complexType>
</xs:schema>

Example:

<?xml version="1.0" encoding="UTF-8"?>
<PrintMapResponse xmlns="http:www.deegree.org/wmps">
    <timestamp>14:20:00-05:00</timestamp>
    <message>Ihr Druckauftrag wurde erfolgreich entgegen genommen. Sie werden per

 Email benachrichtigt, sobald der Auftrag abgearbeitet ist</message>
    <expectedProcessingTime>PT2H30M</expectedProcessingTime>
</PrintMapResponse>

The element <timestamp> declares the time that the print job was received by 
the WMPS. Using the optional element <message> it is possible to get textual 
information  about  the  successful  incoming  of  the  request.  The  element 
<expectedProcessingTime> is also optional and gives the expected processing 
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time for the print job; in the example it amount to two hours and 30 minutes (not 
yet implemented).

After  returning  the  incoming  affirmation  the  connection  between  client  and 
server  is  closed.  If  during processing  of  the print  job a  problem occurs,  e.g. 
because the printer rejects further jobs or one of the embedded data sources is 
not accessible, or if the job is successfully finished, the user can not be informed 
instantenous. Instead, he will be sent an email to the address provided with the 
print request that informs about the status of the print job and e.g. asks the user  
to fetch the map from the corresponding administrator.

4.9 Response in case of error

If  an  error  occurs  during  receiving  of  a  request  or  during  processing  of  a 
GetCapabilities request , the user is informed instantaneous by sending of an 
exception. The format of the response corresponds to the format defined for OGC 
Web Services by by OWS common 1.1.0.
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5 Basic configuration

The configuration  of  the print  service  corresponds  essentially  to  the deegree 
WMS configuration  that  is  referred  to  at  this  place.  As  one  of  the  additional 
configuration  elements  the  definition  of  <deegreewmps:CacheDatabase>  is 
needed.  This  element  defines  the  parameters  needed  for  establishing  the 
connection to a database used for intermediate storage of requests. It is defined 
inside the <deegreewmps:DeegreeParam> element.

<deegreewmps:DeegreeParam>
...
<deegreewmps:CacheDatabase>

<deegreewmps:JDBCConnection xmlns="http://www.deegree.org/jdbc">
<deegreewmps:Driver>driver</deegreewmps:Driver>
<deegreewmps:Url>database.url</deegreewmps:Url>
<deegreewmps:User>username</deegreewmps:User>
<deegreewmps:Password>password</deegreewmps:Password>

</deegreewmps:JDBCConnection>
</deegreewmps:CacheDatabase>
...
</deegreewmps:DeegreeParam>

Additionally it is necessary to define <deegreewmps:PrintMapParam> inside of 
<deegreewmps:DeegreeParam>.

<deegreewmps:DeegreeParam>
...
<deegreewmps:PrintMapParam>

<!-- default: 300 (dpi) -->
<deegreewmps:TargetResolution>300</deegreewmps:TargetResolution>
<!-- default format 'pdf'. Supported formats 'pdf','rtf','html' -->
<deegreewmps:Format>pdf</deegreewmps:Format>
<deegreewmps:Template>
<deegreewmps:Directory>../../Template</deegreewmps:Directory>

</deegreewmps:Template>
<deegreewmps:PlotDirectory>download</deegreewmps:PlotDirectory>
<deegreewmps:OnlineResource>
http://MyServer:8081/portal

</deegreewmps:OnlineResource>
<deegreewmps:PlotImageDirectory>
WEB-INF/temp/image

</deegreewmps:PlotImageDirectory>
<deegreewmps:MailHost>mail.lat-lon.de</deegreewmps:MailHost>
<deegreewmps:MailHostUser>loginname</deegreewmps:MailHostUser>
<deegreewmps:MailHostPassword>password</deegreewmps:MailHostPassword>
<deegreewmps:AdministratorEMailAddress>poth@lat-lon.de
</deegreewmps:AdministratorEMailAddress>
<deegreewmps:MailTextTemplate>
The PrintMap request recieved has been successfully printed out in the 
format requested. You can access the result at {0}/{1}

</deegreewmps:MailTextTemplate>
</deegreewmps:PrintMapParam>

...
</deegreewmps:DeegreeParam>

Using the element <deegreewmps:PrintMapParam> the format of respones to 
PrintMap requests is declared. The default behavious is to export the result as 
'pdf', alternatively the formats 'html' and 'rtf' can be used. The print templates 
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(see below) have to be made accessible in a defined directory, that is declared 
using <deegreewmsp:Template>.

The  directory  for  intermediate  storage  of  partial  results  is  defined  by 
<deegreewmps:PlotImageDirectory>. It serves solely the temporary storage of 
intermediate  results  and  should  therefore  not  be  visible  outside  of  the 
application.  The  element  <deegreewmps:PlotDirectory>  defines  the  directory 
used  for  the  final  print  results.  Depending on the  way of  access  (directly  or 
indirectly  by a  separate  web application)  this  should  either  be  visible  or  not 
outside  of  the  application.  The  optional  <deegreewmps:OnlineResource> 
declares the base address that resulting files are made available with.

As already explained above, the user will be achkowledged via email as soon as 
his  job  is  successfully  finished.  This  email  includes  a  link  that  allows  the 
download of the result.  The administrator  has to declare the used email  host 
using  <deegreewmsp:MailHost>.  <deegreewmps:MailHostUser>  and 
<deegreewmps:MailHostPassword>  are  optional  in  case  authentication  is 
required. The element <deegreewmps:AdministratorEMailAddress> defines the 
sender that is used for the sent email. A complete WMPS Capabilities document 
can be found in annex 2.

In addition to the configuration of the capabilities the print templates have also 
to be configured. Internally deegree WMPS uses the Open Source project Jasper-
Reports. This uses templates allowing to position graphics and textual elements 
freely  on the printing template.  For  creation and adaptation of  the templates 
iReport can be used (figure 3). Besides a map picture, a legend and north arrow 
as predefined graphical elements a template can include an arbitrary number of 
static or dynamic textual  areas as well  as static graphical  elements. Dynamic 
elements are those that are created at run-time out of the information give as 
part of the PrintMap request. The content of static elements is declared at design 
time (e.g. a logo).
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Appendix A Schema definition for error messages (from 
OWS Common 1.1.0)
<?xml version="1.0" encoding="UTF-8"?>
<schema targetNamespace="http://www.opengis.net/ows"
 xmlns:ows="http://www.opengis.net/ows" xmlns="http://www.w3.org/2001/XMLSchema"
 elementFormDefault="qualified" version="1.1.0" xml:lang="en">
    <annotation>
        <appinfo>owsExceptionReport.xsd 2005-09-19</appinfo>
        <documentation>This XML Schema Document encodes the Exception Report 

response to all OWS operations. 
Copyright (c) Open Geospatial Consortium (2005) </documentation>

    </annotation>
    <!-- ==============================================================

elements and types
============================================================== -->

    <element name="ExceptionReport">
        <annotation>
            <documentation>Report message returned to the client that requested any

 OWS operation when the server detects an error while processing that
 operation request. </documentation>

        </annotation>
        <complexType>
            <sequence>
                <element ref="ows:Exception" maxOccurs="unbounded">
                    <annotation>
                        <documentation>Unordered list of one or more Exception

 elements that each describes an error. These Exception
elements shall be interpreted by clients as being independent

 of one another (not hierarchical). </documentation>
                    </annotation>
                </element>
            </sequence>
            <attribute name="version" use="required">
                <annotation>
                    <documentation>Specification version for OWS operation. The 
string value shall contain one x.y.z "version" value (e.g., "2.1.3"). A version 
number shall contain three non-negative integers separated by decimal points, in 
the form "x.y.z". The integers y and z shall not exceed 99. Each version shall be 
for the Implementation Specification (document) and the associated XML Schemas to 
which requested operations will conform. An Implementation Specification version 
normally specifies XML Schemas against which an XML encoded operation response must 
conform  and  should  be  validated.  See  Version  negotiation  subclause  for  more 
information. </documentation>
                </annotation>
                <simpleType>
                    <restriction base="string">
                        <pattern value="\d+\.\d?\d\.\d?\d"/>
                    </restriction>
                </simpleType>
            </attribute>
            <attribute name="language" type="language" use="optional">
                <annotation>
                    <documentation>Identifier of the language used by all included 
exception text values. These language identifiers shall be as specified in IETF RFC 
1766.  When  this  attribute  is  omitted,  the  language  used  is  not  identified. 
</documentation>
                </annotation>
            </attribute>
        </complexType>
    </element>
    <!-- ======================================================= -->
    <element name="Exception" type="ows:ExceptionType"/>
    <!-- ======================================================= -->
    <complexType name="ExceptionType">
        <annotation>
            <documentation>An Exception element describes one detected error that a

 server chooses to convey to the client. </documentation>
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        </annotation>
        <sequence>
            <element name="ExceptionText" type="string" minOccurs="0"

 maxOccurs="unbounded">
                <annotation>
                    <documentation>Ordered sequence of text strings that describe 
this specific exception or error. The contents of these strings are left open to 
definition  by  each  server  implementation.  A  server  is  strongly  encouraged  to 
include at least one ExceptionText value, to provide more information about the 
detected  error  than  provided  by  the  exceptionCode.  When  included,  multiple 
ExceptionText  values  shall  provide  hierarchical  information  about  one  detected 
error, with the most significant information listed first. </documentation>
                </annotation>
            </element>
        </sequence>
        <attribute name="exceptionCode" type="string" use="required">
            <annotation>
                <documentation>A code representing the type of this exception,

 which shall be selected from a set of exceptionCode values
 specified for the specific service operation and server.
</documentation>

            </annotation>
        </attribute>
        <attribute name="locator" type="string" use="optional">
            <annotation>
                <documentation>When included, this locator shall indicate to the 
client  where  an  exception  was  encountered  in  servicing  the  client's  operation 
request. This locator should be included whenever meaningful information can be 
provided by the server. The contents of this locator will depend on the specific 
exceptionCode and OWS service, and shall be specified in the OWS Implementation 
Specification. </documentation>
            </annotation>
        </attribute>
    </complexType>
</schema>
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Anhang C: Schema definition for PrintMap requests
<?xml version="1.0" encoding="UTF-8"?>
<xs:schema targetNamespace="http://www.deegree.org/wmps" 
xmlns:xs="http://www.w3.org/2001/XMLSchema" 
xmlns:deegree="http://www.deegree.org/wmps" 
xmlns:sld="http://www.opengis.net/sld" 
xmlns:gml="http://www.opengis.net/gml" elementFormDefault="qualified">

<xs:import namespace="http://www.opengis.net/gml" 
schemaLocation="geometryBasic0d1d.xsd"/>

<xs:import namespace="http://www.opengis.net/sld" 
schemaLocation="StyledLayerDescriptor.xsd"/>

<xs:element name="PrintMap">
<xs:complexType>

<xs:sequence>
<xs:element name="Layers" type="deegree:LayersType"/>
<xs:choice>

<xs:element ref="gml:Envelope"/>
<xs:sequence>

<xs:element name="Center" type="deegree:CenterType"/>
<xs:element name="ScaleDenomiator" type="xs:positiveInteger"/>

</xs:sequence>
</xs:choice>
<xs:element name="Transparent" type="xs:boolean" minOccurs="0" 

default="false"/>
<xs:element name="BGColor" type="xs:string" minOccurs="0" 

default="0xFFFFFF"/>
<xs:element name="Legend" type="xs:boolean" minOccurs="0" 

default="false"/>
<xs:element name="ScaleBar" type="xs:boolean" minOccurs="0" 

default="false"/>
<xs:element name="Template" type="xs:string" minOccurs="0" 

default="default"/>
<xs:element name="EMailAddress" type="xs:string"/>
<xs:element name="TextAreas" type="deegree:TextAreasType" 

minOccurs="0"/>
</xs:sequence>
<xs:attribute name="version" type="xs:string" use="required"/>

</xs:complexType>
</xs:element>
<xs:complexType name="LayersType">

<xs:sequence>
<xs:choice>

<xs:element ref="sld:NamedLayer" minOccurs="1" maxOccurs="unbounded"/>
<xs:element ref="sld:UserLayer" minOccurs="1" maxOccurs="unbounded"/>

</xs:choice>
</xs:sequence>

</xs:complexType>
<xs:complexType name="TextAreaType">

<xs:sequence>
<xs:element name="Name" type="xs:string"/>
<xs:element name="Text" type="xs:string"/>

</xs:sequence>
</xs:complexType>
<xs:complexType name="TextAreasType">

<xs:sequence>
<xs:element name="TextArea" type="deegree:TextAreaType" minOccurs="1" 

maxOccurs="unbounded"/>
</xs:sequence>

</xs:complexType>
<xs:complexType name="CenterType">

<xs:sequence>
<xs:element ref="gml:pos"/>

</xs:sequence>
</xs:complexType>

</xs:schema>
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Anhang B: WMPS Capabilities schema

<?xml version="1.0" encoding="UTF-8"?>
<WMT_PS_Capabilities xmlns:deegree="http://www.deegree.org/wmps" 

        xmlns:deegreewmps="http://www.deegree.org/wmps" 
                  xmlns:gml="http://www.opengis.net/gml" version="1.1.1" 

 updateSequence="1.1.0">
<deegreewmps:DeegreeParam>
<deegreewmps:DefaultOnlineResource xmlns:xlink="http://www.w3.org/1999/xlink"

xlink:type="simple" 
xlink:href="http://127.0.0.1:8080/deegree-

wmps/services"/>
<!-- default = 100 (MB) -->
<deegreewmps:CacheSize>100</deegreewmps:CacheSize>
<!-- maximum lifetime of the processes in the wmps; default = 3600 (sec)-->
<deegreewmps:MaxLifeTime>3600</deegreewmps:MaxLifeTime>
<!-- maximum time for the execution of a request until an exception of time-ex

  ceed is thrown default 15 Sekunden -->
<deegreewmps:RequestTimeLimit>35</deegreewmps:RequestTimeLimit>
<!-- determines the quality of the map/image generated from a PrintMap request.

    the parameter only will be evaluated if the desired format is able to handle 
      it. the range of values is 0 ... 1, where 1 is best and 0 is worst. Default
       is 0.95     -->

<deegreewmps:MapQuality>1.00</deegreewmps:MapQuality>
<!-- maximum map width that can be requested. default = 1000 -->
<deegreewmps:MaxMapWidth>5000</deegreewmps:MaxMapWidth>
<!-- maximum map height that can be requested. default = 1000 -->
<deegreewmps:MaxMapHeight>5000</deegreewmps:MaxMapHeight>
<!-- copyright note that will be  drawed at the letf side of the maps bottom -->
<Copyright>(c) deegreewmps 2006</Copyright>
<!-- returns the URl where the DTD for OGC wmps capabilities DOCTYPE definiton
  is located. default = 

        http://schemas.opengis.net/wmps/1.1.1/wmps_MS_Capabilities.dtd -->
<deegreewmps:DTDLocation>
<deegreewmps:OnlineResource xmlns:xlink="http://www.w3.org/1999/xlink" 

     xlink:type="simple"    
    xlink:href="http://schemas.opengis.net/wmps/1.1.1/WMS_MS_Capabilities.dtd">

</deegreewmps:OnlineResource>
</deegreewmps:DTDLocation>
<!-- define a proxy server if the wmps is seperated by a firewall from the DTD-

          location or the locations of connected REMOTEWFS, REMOTEWCS and REMOTEWMS 
       as an alternative you can set commandline parameters at the call of the 

          java interpreter like this: java -DproxyHost=131.220.106.104
           -DproxyPort=1234 -classpath ...

-->
<!--Proxy proxyHost="131.220.106.104" proxyPort="1234"/-->
<deegreewmps:CacheDatabase>
<deegreewmps:JDBCConnection xmlns="http://www.deegree.org/jdbc">
<deegreewmps:Driver>org.hsqldb.jdbcDriver</deegreewmps:Driver>
<deegreewmps:Url>jdbc:hsqldb:file:/D:/Deploy/wmps_dmz1/database/wmpsPrintMap

    </deegreewmps:Url>
<deegreewmps:User>sa</deegreewmps:User>
<deegreewmps:Password></deegreewmps:Password>

</deegreewmps:JDBCConnection>
</deegreewmps:CacheDatabase>
<deegreewmps:PrintMapParam>
<deegreewmps:Format>pdf</deegreewmps:Format>
<deegreewmps:Template>
<deegreewmps:Directory>../../Template</deegreewmps:Directory>

</deegreewmps:Template>
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<deegreewmps:PlotDirectory>
      D:\Java\Projekte\wuppertal-portal\webapps\portal_dmz1\download

</deegreewmps:PlotDirectory>
<deegreewmps:OnlineResource>

        http://10.19.1.222:8081/portal
     </deegreewmps:OnlineResource>

  <deegreewmps:PlotImageDirectory>
      ../download/image
     </deegreewmps:PlotImageDirectory>

<deegreewmps:MailHost>mail.lat-lon.de</deegreewmps:MailHost>
<deegreewmps:MailHostUser>loginname</deegreewmps:MailHostUser>
<deegreewmps:MailHostPassword>password</deegreewmps:MailHostPassword>
<deegreewmps:AdministratorEMailAddress>poth@lat-lon.de
</deegreewmps:AdministratorEMailAddress>

</deegreewmps:PrintMapParam>
</deegreewmps:DeegreeParam>
<Service>
<Name>deegreewmps wmps</Name>
<Title>deegreewmps wmps</Title>
<!-- abstract und keywords are optional -->
<Abstract>wmps reference implementation</Abstract>
<KeywordList>
<Keyword>deegreewmps</Keyword>
<Keyword>WMPS</Keyword>

</KeywordList>
<OnlineResource xmlns:xlink="http://www.w3.org/1999/xlink" xlink:type="simple" 

xlink:href="http://127.0.0.1:8080/deegree-wmps/services">
</OnlineResource>
<ContactInformation>
<ContactPersonPrimary>
<ContactPerson>Andreas Poth</ContactPerson>
<ContactOrganization>lat/lon</ContactOrganization>

</ContactPersonPrimary>
<ContactPosition>Developer</ContactPosition>
<ContactAddress>
<AddressType>Office</AddressType>
<Address>Aennchenstr. 19</Address>
<City>Bonn</City>
<StateOrProvince>NRW</StateOrProvince>
<PostCode>53177</PostCode>
<Country>Germany</Country>

</ContactAddress>
<ContactVoiceTelephone>004922818496-0</ContactVoiceTelephone>
<ContactFacsimileTelephone>004922818496-29</ContactFacsimileTelephone>
<ContactElectronicMailAddress>poth@lat-lon.de</ContactElectronicMailAddress>

</ContactInformation>
<Fees>none</Fees>
<AccessConstraints>none</AccessConstraints>

</Service>
<Capability>
<Request>
<!-- by default available -->
<GetCapabilities>
<!-- default and mandatory = application/vnd.ogc.wmps_xml -->
<Format>application/vnd.ogc.wmps_xml</Format>
<DCPType>

<HTTP>
<Get>

<OnlineResource
                             xmlns:xlink="http://www.w3.org/1999/xlink"
                             xlink:type="simple" 
                   xlink:href="http://127.0.0.1:8080/deegree-wmps/services?"/>
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</Get>
<!-- POST isn't supported -->

</HTTP>
</DCPType>

</GetCapabilities>
<!-- by default available -->
<PrintMap>
<!-- default = image/gif; image/png; image/jpg -->
<!-- mandatory = image/png -->
<Format>image/gif</Format>
<Format>image/png</Format>
<Format>image/jpg</Format>
<Format>image/tif</Format>
<Format>image/bmp</Format>
<DCPType>

<HTTP>
<Get>

<OnlineResource 
xmlns:xlink="http://www.w3.org/1999/xlink" xlink:type="simple" 
xlink:href="http://127.0.0.1:8080/deegree-wmps/services?"/>

</Get>
<Post>

<OnlineResource 
xmlns:xlink="http://www.w3.org/1999/xlink" xlink:type="simple" 
xlink:href="http://127.0.0.1:8080/deegree-wmps/services"/>

</Post>
</HTTP>

</DCPType>
</PrintMap>

</Request>
<Exception>
<!-- default & mandatory= application/vnd.ogc.se_xml -->
<Format>application/vnd.ogc.se_xml</Format>
<Format>application/vnd.ogc.se_inimage</Format>
<Format>application/vnd.ogc.se_blank</Format>

</Exception>
<!-- optional; default = all false -->
<UserDefinedSymbolization SupportSLD="1" UserLayer="1" UserStyle="1" 

                              RemoteWFS="0"/>
<!-- cascaded is optional and default=false -->
<!-- TOP LAYER -->
<Layer queryable="0" cascaded="0" noSubsets="0">
<Name>TopLevel</Name>
<Title>deegree demo-CD top-level-layer</Title>
<!-- abstract and keyword are optonal -->
<Abstract>the top-level-layer of the deegree demo-CD</Abstract>
<KeywordList>
<Keyword>deegree</Keyword>
<Keyword>demo-CD</Keyword>
<Keyword>layer</Keyword>

</KeywordList>
<SRS>EPSG:4326</SRS>
<SRS>EPSG:31466</SRS>
<SRS>EPSG:31467</SRS>
<!--<LatLonBoundingBox minx="-10" miny="-10" maxx="10" maxy="10"/>-->
<LatLonBoundingBox minx="-180" miny="-90" maxx="180" maxy="90"/>
<!-- default 0 ; 9E99  -->
<ScaleHint min="0" max="999999999"/>
<!-- Bonner daten -->
<Layer queryable="1" noSubsets="0" fixedWidth="0" fixedHeight="0">
<Name>gemischte_bauflaeche</Name>
<Title>Bonn</Title>
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<SRS>EPSG:31466</SRS>
<deegree:DataSource failOnException="1" queryable="1"

                           xmlns:app="http://www.deegree.org/app">
<deegree:Type>LOCALWFS</deegree:Type>
<deegree:Name>app:gemischte_bauflaeche</deegree:Name>
<deegree:GeometryProperty>app:GEOM</deegree:GeometryProperty>

</deegree:DataSource>
<Style>

<Name>default:gemischte_bauflaeche</Name>
<Title>Legend</Title>
<!--LegendURL width="72" height="72">

<Format>image/gif</Format>
<OnlineResource xmlns:xlink="http://www.w3.org/1999/xlink"

                     xlink:type="simple" 
             xlink:href="http://www.exploremaps.com/Media/Legend%20for%20web.jpg"/>

</LegendURL-->
</Style>

</Layer>
<!-- Demo CD layers -->
<Layer queryable="1" opaque="0" noSubsets="0" fixedWidth="0" fixedHeight="0">
<Name>europe:country</Name>
<Title>Country border</Title>
<SRS>EPSG:4326</SRS>
<deegree:DataSouce failOnException="1" queryable="1"

                          xmlns:app="http://www.deegree.org/app">
<deegree:Type>REMOTEWMS</deegree:Type>
<deegree:OWSCapabilities>

<deegree:OnlineResource 
                         xmlns:xlink="http://www.w3.org/1999/xlink" 
                         xlink:type="simple" 
                         xlink:href="http://127.0.0.1:808/deegree-wms/services?
                       service=WMS&amp;version=1.1.1&amp;request=GetCapabilities"/>

</deegree:OWSCapabilities>
<deegree:FilterCondition>

<deegree:WMSRequest><!
[CDATA[Version=1.1.1&FORMAT=image/png&TRANSPARENT=false&EXCEPTIONS=application/vnd.
ogc.se_inimage&BGCOLOR=0xffffff&LAYERS=country&STYLES=]]></deegree:WMSRequest>

</deegree:FilterCondition>
</deegree:DataSouce>
<Style>

<Name>default:country</Name>
<Title>country border</Title>
<!--LegendURL width="72" height="72">

<Format>image/gif</Format>
<OnlineResource xmlns:xlink="http://www.w3.org/1999/xlink" 

                                    xlink:type="simple" 
            xlink:href="http://www.exploremaps.com/Media/Legend%20for%20web.jpg"/>

</LegendURL-->
</Style>

</Layer>
</Layer>

</Capability>
</WMT_PS_Capabilities>
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